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ABSTRAK

Perkembangan teknologi saat ini meningkat sangat pesat dan sangat terasa dalam dunia industri dan
masyarakat salah satunya penggunaan teknologi rumah pintar (smart home), pada masaini banyak perangkat
listrik yang terintegrasi dengan komputer, hal ini tentunya sangat berguna untuk pekerjaan manusia dalam
mengoperasikan perangkat listrik. Tujuan dari penelitian rumah pintar ini adalah untuk mengontrol perangkat
listrik dan penerangan dalam satu sistem yang bertujuan untuk menggunakan energi listrik pada suatu
bangunan secara efektif dan efisien. Pada penelitian ini dirancang model sistem smart home yang bekerja
secara terkontrol berbasis Internet of Things (1oT) menggunakan mikrokontroler Arduino dan ESP8266 serta
metode prototype. Sistem prototipe dibuat dan dapat dikontrol dari jarak jauh menggunakan Firebase Realtime
Database. Dari sini dapat disimpulkan bahwa rumah pintar dapat mengontrol peralatan rumah tangga seperti
kipas angin,televisi dan lampu serta dapat dikendalikan dari jarak jauh oleh pengguna dengan memberikan
perintah melalui rumah pintar. Aplikasi dan terhubung ke mikrokontroler untuk mengoperasikan dan
mengontrol peralatan rumah tangga untuk mengurangi konsumsi energi listrik ketika pengguna lupa
mematikan peralatan rumah tangga.

Kata Kunci : Arduino, ESP8266, smart home, Firebase Realtime Database, Internet Of Things,Android.

ABSTRACT

The development of technology is currently increasing very rapidly and is felt in the industrial world and
society, one of which is the use of smart home technology, at this time many electrical devices are integrated
with computers, this is certainly very useful for human work in operating electrical devices. The purpose of this
smart home research is to control electrical and lighting devices in a system that aims to use electrical energy
in a building effectively and efficiently. In this study, a smart home system model that works in a controlled
manner based on the Internet of Things (IoT) was designed using Arduino and ESP8266 microcontrollers and
the prototype method. A prototype system is built and can be controlled remotely using the Firebase Realtime
Database. From this it can be concluded that smart homes can control household appliances such as fans,
televisions and lights and can be controlled remotely by the user by giving commands through the smart home.
Application and connect to the microcontroller to operate and control household appliances to reduce the
consumption of electrical energy when the user forgets to turn off household appliances.

Keywords: Arduino, ESP8266, smart home, Firebase Realtime Database, Internet Of Things, Android.
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1. Pendahuluan

Perkembangan teknologi saat ini berkembang
sangat pesat, dan dapat dirasakan dalam dunia industri
maupun masyarakat. Salah satunya yaitu dengan
pemanfaatan teknologi yang ada, seperti pembuatan
rumah pintar (Smart Home). Rumah pintar atau lebih
dikenal denganistilah smart home adalah sebuah tempat
tinggal atau kediaman yang menghubungkan jaringan
komunikasi dengan peralatan listrik yang dimungkinkan
dapat dikontrol, dimonitor atau diakses dari jarak jauh.
Smart home juga dapat meningkatkan efisiensi,
kenyamanan dan keamanan dengan menggunakan
teknologi secara otomatis. [6]

Pada saat sekarang ini banyak perangkat-
perangkat listrik yang bekerja secara terintegrasi dengan
sistem komputer. Hal ini tentunya akan sangat
membantu pekerjaan manusia dalam mengoperasikan
perangkat listrik tersebut, Smart Home memiliki
beberapa manfaat seperti memberikan kenyamanan yang
lebih baik, keselamatan dan keamanan yang lebih
terjamin, dan menghemat penggunaan energi listrik. [5]

Dengan menerapkan perangkat Smart Home di
rumah atau perkantoran, perangkat- perangkat listrik
akan dapat bekerja secara otomatis sesuai dengan
kebutuhan pengguna. Pengguna juga dapat memantau
dan mengendalikan perangkat- perangkat listrik di dalam
rumah dari jarak jauh melalui suatu saluran komunikasi
seperti melalui jaringan internet, Wi-Fi atau bluetooth.
Aplikasi rumah pintar (smart home) pengendali
peralatan elektronik rumah tangga berbasis 10T Kontrol
peralatan elektronik dapat dilakukan dengan aplikasi
smart home pengendali peralatan elektronik rumah
tangga berbasis loT. [3]

1.2 Rumusan Masalah
Berdasarkan latar belakang yang telah diuraikan,
maka dapat dirumuskan masalah yaitu:
1. Proses pengendalian saklar dan control pada
listrik masih secara manual.
2. Pemakaian energi listrik secara berlebihan pada
saat pengguna lupa mematikan peralatan listrik.
3. Adanya kesulitan control peralatan listrik saat
pengguna mengalami sakit yang diharuskan
untuk bedrest.

1.3 Tujuan Penelitian
Berdasarkan permasalahan yang diteliti, maka

tujuan dari skripsi ini adalah:

1. Mewujudkan sistem kendali secara wireless
melalui  smartphone  untuk  memudahkan
pengguna.

2. Memungkinan pengguna untuk mengontrol
perangkat listrik secara jarak jauh.

3. Membantu orang yang sedang sakit untuk
mengontrol perangkat listrik.

1.4 Internet of Things (1oT)

Internet of Things (loT) adalah pertama kali
digunakan pada tahun 1999 oleh pelopor teknologi
inggris kevin ashton untuk menggambarkan suatu
system dimana benda-benda di dunia fisik bisa

dihubungkan ke internet oleh sensor. Kevin ashton
menciptakan istilah itu untuk menggambarkan
kekuatan menghubungkan Radio frekuensi Indentifkasi
(RFID) vyang digunakan dalam rantai pasokan
perusahaan ke internet untuk menghitung dan melacak
barang tanpa perlu manusia intervensi. [8]

1.5 Smart Home

Smart home atau Rumah Pintar adalah sebuah
sistem berbantuan computer yang akan memberikan
segala kenyamanan, keselamatan, keamanan dan
penghematan energi, yang berlangsung secara otomatis
dan terprogram melalui komputer, pada gedung atau
rumah tinggal anda. Dapat digunakan untuk
menggendalikan hampir semua perlengkapan dan
peralatan di rumah anda, mulai dari pengaturan tata
lampu hingga ke berbagai alat-alat rumah tangga, yang
perintahnya dapat dilakukan dengan menggunakan
suara, sinar inframerah, atau melalui kendali jarak jauh
(remote). Hanya dengan melakukan hubungan
telepon, maka anda dapat mengatur buka-tutup tirai
yang mengunakan motor, mengatur penerangan di
dalam atau luar rumah, mengawasi seluruh aktivitas
yang terjadi di rumah, atau mudahnya, bisa diartikan
bahwa anda mengatur semua prasarana rumah atau
kantor anda yang menggunakan sumberdaya listrik
sebagai pembangkit kerjanya. Di rumah-rumah yang
berlahan luas, Smarthome lebih terasa manfaatnya. [5]

1.6 Firebase Realtime Database

Firebase Realtime Database adalah database yang
di-host di cloud. Data disimpan sebagi JSON dan
disinkronkan secara realtime ke setiap klien yang
terhubung. Ketika anda membuat aplikasi lintas-
plataform dengan SDKAndroid, iOS, dan JavaScript,
semua klien akan berbagi sebuah instance Realtime
Database dan menerima update data terbaru secara
otomatis.

Realtime Database adalah database NoSQL,
sehingga memiliki pengoptimalan dan fungsionalitas
yang berbeda dengan database terkait. API
Realtime Database dirancang agar hanya
mengizinkan operasi yang dapat dijalankan dengan
cepat. Hal ini memungkinkan untuk membangun
pengalaman realtime yang luar biasa dan dapat
melayani jutaan pengguna tanpa mengorbankan
kemampuan respon. Oleh karena itu, perlu dipikirkan
bagaimana pengguna mengakses data, kemudian buat
struktur data sesuai dengan kebutuhan tersebut.
(Wikipedia)

1.7 Arduino

Arduino adalah perangkat yang mampu
mendeteksi dan mengendalikan perangkat tambahan
lainnya. Arduino merupakan perangkat open source
berbasis komputer pada papan mikrokontroler
sederhana dan berupa perangkat lunak untuk menulis
kode program pada papan mikrokontroler.

Arduino dapat digunakan untuk merancang
objek interaktif, menerima input dari berbagai macam
saklar atau sensor, dan mengendalikan berbagai lampu,
motor dan perangkat kendali lainnya. Kinerja sistem
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arduino dapat berupa sistem yang mandiri atau dapat

berkomunikasi dengan perangkat lunak lainnya.
1.8 ESP8266

ESP8266 adalah sebuah chip yang sudah
lengkap dimana didalamnya sudah termasuk
processor, memori dan juga akses ke GPIO. Hal ini
menyebabkan ESP8266 dapat secara langsung
menggantikan Arduino dan ditambah lagi dengan
kemampuannya untuk mensupport koneksi wifi
secara langsung. [1]

1.9 Relay

Relay adalah Saklar (Switch) yang dioperasikan
secara  listrik dan  merupakan  komponen
Elektromekanikal yang terdiri dari 2 bagian utama
yakni  Elektromagnet (Coil) dan Mekanikal
(seperangkat ~ Kontak  Saklar/Switch).  Relay
menggunakan  Prinsip  Elektromagnetik  untuk
menggerakkan Kontak Saklar sehingga dengan arus
listrik yang kecil (low power) dapat menghantarkan
listrik yang bertegangan lebih tinggi. Sebagaicontoh,
dengan Relay yang menggunakanElektromagnet 5V
dan 50 mA mampu menggerakan Armature Relay
(yang  berfungsi sebagai  saklarnya) untuk
menghantarkan listrik 220V 2A. [2]

1.20 Sensor Suhu

Termometer berguna untuk mengukur suhu
serta temperature, akan tetapi untuk mengukur
Termometer berguna untuk mengukur suhu serta
temperature, akan tetapi untuk mengukur suhu dan
temperatur pada Arduino menggunakan sensor suhu
dan sensor suhu sendiri memiliki beberapa macam
jenis ada sensor suhu LM35, DHT11, DHT22 dan
DS18B20. Untuk  penelitian  ini  penulis
menggunakan sensor suhu DHT11, dimana sensor
ini dapat mengukur dua parameter sekaligus yaitu
suhu dan kelembapan udara. Sensor ini memiliki
keluaran sinyal digital yang dikalibrasidengan sensor
suhu dan kelembapan. Hal ini membuat stabilitas
kinerja sensor menjadi sangat baik dalam jangka
panjang. Selain itu sensor ini memiliki respon yang
cepat, kemampuan anti gangguan dan hemat biaya
karena sensor inimemiliki dua parameter sekaligus.

[4]

1.21Sensor Infrared

Sensor Inframerah adalah infrared ini
merupakan komponen peka cahaya yang dapat
berupa dioda (photodioda) atau transistor
(phototransistor). Komponen ini akan mengubah
energi cahaya, dalam hal ini energi cahaya infrared,
menjadi pulsa-pulsa sinyal listrik. Komponen ini
harus mampu mengumpulkan sinyal infrared
sebanyak mungkin sehingga pulsa-pulsa sinyal
listrik yang dihasilkan akan baik. Jika sinyalinfrared
yang diterima intensitasnya lemah, maka receiver
infrared tersebut harus mempunyai pengumpul
cahaya (light collector) yang cukup baik dan sinyal
pulsa yang dihasilkan oleh sensor infrared ini harus
dikuatkan.

1.22 Sensor LDR

Sensor Cahaya atau LDR (Light Dependent
Resistor) adalah sebuah Resistor yang memiliki
nilai hambatan atau nilai resistansi yang
bergantung pada intensitas cahaya yang
diterimanya. Disaat terang nilai hambatan LDR
akan menurun dan di saat gelap nilai hambatan
akan naik. Dengan kata lain LDR berfungsi untuk
menghantarkan arus listrik jika menerima sejumlah
intensitas cahaya (Kondisi Terang) dan
menghambat arus listrik dalam kondisi gelap. [7]

1.23 App Inventor

App Inventor adalah Integrated Development
Environment (IDE) yang ditujukan bagi semua
kalangan  untuk  mengembangkan aplikasi
Android tanpa harus berpengalaman dalam dunia
pemrograman. Aplikasi ini merupakan aplikasi
open source (sumber terbuka) berbasis web yang
semulanya disediakan oleh Google dan sekarang
dikelola oleh  Massachusetts Institute  of
Technology (MIT).

App Inventor didesain dengan simple dan
mudah dimengerti. App Inventor juga memiliki
tool berbasis drag/drop dan visual blocks
programming untuk mengembangkan aplikasi
yang berjalan di Android Operating Sytem.
Sehingga kita tidak perlu menuliskan kodekode
pemrograman untuk membuat aplikasi. Fiture
Visual Blocks Programming mampu
mentransformasikan pengkodean bahasa
pemrograman berbasis teks kedalam bahasa
visual dalam bentuk kode-kode program. [2]

2. Pembahasan

Sistem vyang dibuat perancangan sistem
kendali Smarthome berbasis android menggunakan
Arduino dan ESP8266 yang terdiri dari beberapa
komponen yaitu Arduino Nano, ESP8266, Lampu
LED 3watt, Relay, LCD 16x2 (12C), sensor DHT-
11, sensor LDR, dan sensor Infrared sebagaikendali
perangkat elektronik jarak jauh dan monitoring suhu
dan kelembaban. Sistem ini berfungsi untuk
menyalakan atau mematikan lampu/relay secara
jarak jauh dan mengecek suhu dan kelembaban.
Dengan demikian sistem ini dapat membuat
pengguna tidak perlu repot-repot mencari saklar
untuk mematikan atau menyalakannya semua sudah
ada dalam aplikasi android.

2.1 Analisis Kebutuhan Fungsional
Kebutuhan fungsional adalah kebutuhan yang
berisi proses-proses apa saja yang nantinya
dilakukan oleh aplikasi yang berisi informasi-
informasi apa saja yang harus ada dan dihasilkan
oleh aplikasi. Adapun analisa kebutuhan fungsional
meliputi:
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a. Sistem harus bisa memberikan akses kepada
smartphone pengguna untuk kendali lampu,
kendali relay dan memonitoring suhu dan
kelembaban.

b. Setiap modul dan perangkat yang digunakan
berjalan dengan semestinya.

c. Sistem bisa terkoneksi dengan smartphone
pengguna dengan baik.

2.2 Analisis Kebutuhan Perangkat Keras
Hardware merupakan kebutuhan yang sangat

mendasar

dalam pembutan

sistem Smarthome

sebagai berikut :

1.

©ooNE WD

Laptop

NodeMCU ESP8266
Relay 2 Channel
Lampu 2.5watt
Breadboard

Adaptor 7-12V
Shield NodeMCU
Kabel Jumper

Stock Kontak

2.3 Analisis Kebutuhan Perangkat Lunak

Adapun perangkat

lunak yang digunakan

sebagai berikut:

1.
2.

3.

Microsoft windows 10
Arduino IDE, digunakan
membuat kode program.
Firebase, digunakan sebagai database
realtime ke aplikasi android.

Aplikasi MIT App Inventor 2,
digunakan untuk membuat aplikasi
android.

Fritzing.0.9.3b.64.pc, digunakan untuk
membuat skema alat.

untuk

2.4 Diagram Blok

INPUT PROSES

OUTPUT

=

Tombol ON/OFF ESP8266 LCD 16x2 2C

Gambar 2.1 Diagram Blok

2.5 Rangkaian Komponen Smarthome

Aktor

Gambar 2.2 Rangkaian Komponen Smarthome
2.6 Use Case Diagram
Pemodelan untuk mendeskripsikan interaksi
antara satu ataulebih aktor dengan sistem yang akan
dibuat.Berikut adalah model use case diagram :

™

/’///
S Monitoring Suhu

j dan Kelembaban .

Memberi Perintah

AN

N

N

Kendali Relay

Kendali Lampu

Gambar 2.3 Use Case Diagram

2.7 Use Case Skenario

Tabel 2.7 Use Case Scenario

No

Aktor

Login

Aksi aktor

Reaksi sistem

password

Masukan email dan

Cek valid atau
tidaknya  data

input untuk
masuk ke
halaman
Smarthome

Monitoring Suhu dan Kelembaban

Aksi aktor Reaksi sistem
Menampilkan suhu
Menampilkan
kelembaban
Memberi Perintah
Aksi aktor Reaksi sistem
Menekan tombol Menyalakan atau
on/off/Auto mematikan
relay dan
lampu
Logout
Aksi aktor Reaksi sistem

Menekan tombol
Keluar

Keluar dari akses
user dan kembali
ke halaman

login

2.8 Activity Diagram
Diagram yang memodelkan aliran kerja
atau workflow dari urutan aktifitas dalam suatu
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proses yang mengacu pada use case diagram
yang ada.
a. Activity Diagram Login

Akitor

?

Membuka q:llkasl £3 L=

halaman login

Memasulan email
dan passward

I\Ii( tombol Iugln Validasi email dan
pas=word

4

1
|

A
[ A
b

Gambar 2.4 Activity Diagram
Login

b. Activity Diagram Monitoring Suhu dan
Kelembaban

Activity Diagram Monitoring Suhu dan Kelemembaban

Aktor Sistem

?

M ilk
Membuka Aplikasi - enampliian -
halaman smart home

Monitor Suhu dan Mengirim Suhu dan
Kelembaban Kelembaban

Gambar 2.5 Activity Diagram
MonitoringSuhu dan Kelembaban

c. Activity Diagram Memberi Perintah
Lampu

Gambar 2.6 Activity Diagram Perintah

Lampu

d. Activity Diagram Memberi Perintah Relay

Activity Diagram Memberi Perintah Lamp

Gambar 2.7 Activity Diagram Perintah
Relay

e. Activity Diagram Memberi Logout

Activity Diagram Logout

Alktor

Tekan tombol logout E— Kemnah':;:alaman

N
I.I:
\_:_./'

Gambar 2.8 Activity Diagram Logout

2.9 Rancangan Skematik

Gambar 2.14 Rancangan Skematik

Susunan Pin yang digunakan sebagai

berikut:
2. Arduino ke ESP8266 :
a. 2->D5
b. 3->D6

c. GND->GND
1. Arduinoke LED1:

a. Vcc->5V

b. Red->3

c. Green->5
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d. Blue->6
e. GND ->GND
2. Arduino ke LED 2 :

a. Vcc->5V
b. Red->9

c. Green->10
d. Blue->11

e. GND ->GND
3. Arduino ke Sensor DHT-11:
a. Vcc->5V
b. Data->7
c. GND ->GND
4. Arduino ke Sensor LDR :
a. Vcc->5V
b. Data->8
c. GND ->GND
5. Arduino ke Sensor Infrared :
a. Vcc->5V
b. Data->A0
c. GND ->GND
6. Arduino ke Relay :
a. Vcc->5V
b. Data->13
c. GND ->GND
7. [ESP8266 ke LCD 16x2 (12C) :
a. Vcc->5V
b. SDA->D1
c. SCL->D2
d. GND ->GND

2.10 Rancangan Antarmuka Aplikasi

Halaman Login

Email

Password

Login

Gambar 2.15 Rancangan Antarmuka Login

Terdapat input text email dan passwordyang
akan digunakan untuk validasi masuk ke halaman
Smarthome. Terdapat tombol login untuk mulai
validasi.

Smart Home
Suhu Kelembaban
30C 60%
Lampu Dalam ON
Lampu Luar AUTO
Kipas Unplug
Logout

Gambar 2.16 Rancangan Antarmuka Smarthome

Terdapat label suhu dan kelembaban yang
akan menampilkan nilai yang dikirim dari
Arduino. Terdapat 2 tombol ON/OFF/Auto untuk
menghidupkan dan mematikan Lampu dan 1
tombol ON/OFF/Unplug untuk menghidupkan
dan mematikan Relay. Terdapat tombol logout
untuk kembali ke halaman login.

3. Implementasi Sistem dan Pengujian
3.1 Mempersiapkan Perangkat Keras
Persiapan  perangkat  keras  berikut

merupakan bentuk implementasi dari rangkaian

skematik yang telah dibangun. Berikut ini adalah

rangkaian perangkat keras yang telah dibangun :
B\

Gambar 3.1 Rangkaian Perangkat Keras

3.2 Mempersiapkan Perangkat Lunak

Perangkat lunak yang dipersiapkan dan
digunakan haruslah sesuai dengan perangkat
keras yang telah dipersiapkan. Adapun perangkat
lunak (software) yang digunakan selama
membangun Prototype ini adalah sebagai
berikut:

1. Arduino IDE.

Pada dasarnya Arduino IDE tidak
mensupport Wemos D1, oleh karena itu Arduino
IDE harus dapat mensupport Wemos D1 terlebih
dahulu agar Wemos D1 dapat diprogram. Berikut
adalah langkah langkahnya:

a. Instal Arduino IDE versi terbaru.

b. Buka Arduino IDE, kemudian klik File >
Preferences > Additional Boards Manager
URLs.

c. Salin pada field tersebut link berikut ini:
https://github.com/esp8266/Arduino/rel
eas es/download/2.5.0/package esp82.
lalu klik OK.

d. Kemudian, klik Tools > Board [...] >

a. Board Managers.

e. Pada field filter, ketik esp8266 maka
selanjutnya akan muncul nama librarynya
esp8266 by  ESP8266  Community
kemudian instal.

f.  Setelah selesai mengunduh, close, danbuka
ulang Arduino IDE.

g. Pilih boardnya menjadi ESP8266, Kklik
Tools > (Geser kebawah) Pilih
Wemos D1.

h. Pada tahap ini, Wemos D1 sudah bisa di
program dengan Arduino IDE.
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i. Selebihnya bisa dilakukan testing dengan
menyalakan LED_BUILTIN Wemos D1
untuk memastikan.

Setelah melewati langkah langkah diatas,
ikuti langkah berikut ini untuk menyiapkan
program untuk Arduino dan Wemos D1.

a. Buka Program Smarthome Arduino
(ekstensi.ino).

b. Setelah Arduino IDE muncul, koneksikan
Arduino Nano dengan laptop
menggunakan kabel USB yang cocok
dengan slot Arduino Nano.

c. Setelah konek, buka Arduino IDE
kemudian klik Upload atau ctrl+u dan
tunggu sampai progress bar menunjukan
status ‘Done Uploading’.

d. Selesai upload program
SmarthomeArduino.

e. Kemudian buka Program Smarthome Wifi
(ekstensi .ino).

Setelah Arduino IDE muncul, pada bagian

coding terdapat ‘ssid’, ‘password’ dan ‘url’.

#define WIFI_SSID "ssid"
#define WIFI_PASSWORD "password"”
#define DATABASE URL ™url™ //<databaseName>.firebaseio.com

Aplikasi ini akan terhubung dengan
Arduino melalui internet dan dapat digunakan
untuk monitoring (suhu dan kelembaban),
mengontrol lampu dan relay (terminal) pada
rangkaian Prototype dan siap untuk dilakukan
pengujian.

3.3 Pengujian

Pengujian merupakan bagian pentingdalam
siklus pengembangan p. Pengujian dilakukan
untuk menjamin kualitas dan juga mengetahui
kelemahan dari sistem. Tujuan dari pengujian
ini adalah untuk menjamin bahwa perangkat
sistem yang dibangun memiliki kualitas dan
dapat bekerja dengan baik. Pengujian ini
menggunakan metode pengujian Black Box.
Pengujian Black Box digunakan untuk menguji
fungsi-fungsi  khusus dari perangkat yang
dirancang.

3.4 Rencana Pengujian

Adapun rancangan pengujian sistem yang
akan diuji dengan teknik pengujian Prototype
akandikelompokkan dalam tabel 3.1

Tabel 3.1 Tabel Rencana Pengujian

Gambar 3.2 Setting SSID, Password dan url Kelas Uji Butir Uji Deskripsi
Menyalakan dan ..
.. . mematikan Pengujian dengan
f. lIsi ssid dan pas_S\_/vord ubah mer_uadl ssid Rangkaian menggunakann
dan password wifi yang akan digunakan. lampu dengan .
. o e Lampu . perintah tombol
Yang dimaksudkan disini adalah wifi mana perintah tombol pada aplikasi
yang akan digunakan, Wemos D1 akan pada aplikasi.
mengkoneksikan dirinya dengan  wifi Menyalakan dan | Pengujian
tersebut dan url diisi dengan url database Kai mematikan relay | dengan
dari firebase realtime database. Ealng alan dengan perintah menggunakan
g. Setelah itu, koneksikan Wemos D1 dengan elay tombol pada perintah tombol
laptop menggunakan kabel USB yang aplikasi. pada aplikasi.
cocokdengan slot Wemos D1. Ranakaian | Menampilkan Pengujian terhadap
h. Setelah_ koqek, buka Arduino IDE Sensgor suhu dan rangkaian dengan
kemudian kI|I_< Upload atau ctrl+u_ dan kelembapan perantara firebase
;ltjgt%gu‘ Dsamp?]' lprt;g):].res’s bar menunjukan DHT 11 pada aplikasi. realtime database
one Uploading . M lakan d
i. Jika sudah di upload, klik serial monitor di enyaraxan dan
. - mematikan .
pojok kanan atas dan ganti baud rate i ) Pengujian terhadap
L Rangkaian | lampu sesuai .
menjadi 115200. s Kondisi cah rangkaian dengan
j.  Jika setting wifi benar maka akan muncul LteDr];or Kon_k|5| Ca.ayi perantara firebase
tampilan ini pada serial monitor. etika permta_ realtime database.
k. Wemos D1 sudah bisa akses internet lampu otomatis
pada aplikasi
2. Aplikasi Smarthome _ Menampilkan Pengujian
| P ——Ey Rangkaian kondisi rela terhadap
Smarthome sensor y rangkaian dengan
. plug atau unplug .
Siha  jKalemnetan infrared Lo perantara firebase
. pada aplikasi. .
; e e realtime database
Login Smarthome Voo olem.
g 3.3 Kasus dan Hasil Pengujian
Setelah merencanakan pengujian, maka
LLLLLL dilakukanlah pengujian. Berikut ini hasil pengujian yang
telah dilakukan berdasarkan rencana pengujian.
1. Pengujian Lampu Dalam
a. Menyalakan Lampu Dalam dengan

Gambar 3.3 Aplikasi Smarthome Tombol pada Aplikasi



Tabel 3.2 Tabel Pengujian Menyalakan Lampu

Dalam Dengan Tombol

Kasus dan Hasil Uji
Yang .
. . Kesim
Kasus diharapkan Hasil Uji pulan
Menekan
tombol
ON Lampu
lampu dalam OK
dalam menyala

b. Mematikan Lampu Dalam denganTombol
pada Aplikasi

Tabel 3.3 Tabel Pengujian Mematikan Lampu Dalam

Dengan Tombol

Kasus dan Hasil Uji
Yang .
. I Kesim
Kasus diharapkan Hasil Uji pulan
Menekan Lampu
tombol yang
OFF asalnya
lampu menyala oK
dalam menjadi
mati

2. Pengujian Lampu Luar

a. Menyalakan Lampu Luar denganTombol
pada Aplikasi

Tabel 3.4 Tabel Pengujian Menyalakan Lampu
Luar Dengan Tombol

Kasus dan Hasil Uji
Yang Kesim
Kasus diharapkan Hasil Uji pulan
Menekan
tombol
ON Lampu luar OK
Lampu menyala
luar

b. Mematikan Lampu luar dengan pada Aplikasi

Tabel 3.5 Tabel Pengujian Mematikan Lampu Luar
Dengan Tombol

Kasus dan Hasil Uji
Yang ]
Kasus | diharapkan Hasil Uji Kesim
pulan
Menekan | |ampu luar
tombol yang
OFF asalnya OK
Lampu menyala
luar menjadi
mati

3. Pengujian Lampu Relay
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a. Menyalakan Relay dengan Tombol
pada Aplikasi

Tabel 3.6 Tabel Pengujian Menyalakan Relay
Dengan Tombol

Kasus dan Hasil Uji
_ Yang S Kesimp

Kasus | diharapkan Hasil Uji ulan
Menekan

tombol Rel

ON ey oK
Relay menyala
b. Mematikan relay

Tabel 3.7 Tabel Pengujian Mematikan Relay
Dengan Tombol

Kasus dan Hasil Uji
Yang Kesimp
Kasus | diharapkan Hasil Uji ulan
Menekan | Relay yang
tombol asalanya
OFF menyala oK
Relay menjadi
mati
4. Pengujian Sensor DHT11
a. Menampilkan suhu dan

kelembaban pada Aplikasi

Tabel 3.8 Tabel Pengujian menampilkan
suhu dan kelembaban

Kasus dan Hasil Uji

5. Pengujian Sensor LDR

a. Menyalakan
Ketika kondisi gelap

Lampu

Yang Kesim
Kasus diharapkan Hasil Uji P
ulan
Melihat
suhudan | Menampilk
kelemba | ansuhudan OK
ban kelembaban

Luar

Tabel 3.9 Tabel Pengujian Menyalakan

LampuLuar ketika kondisi gelap
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Kasus dan Hasil Uji

Yang

Kasus diharapkan Hasil Uji

Kesimp
ulan

Kondisi
cahaya Lampu luar
gelap menyala

OK

b. Mematikan lampu luar Ketika kondisi terang

Tabel 3.10 Tabel Pengujian Mematikan

Lampu Luar ketika kondisi terang

Kasus dan Hasil Uji

Yang

. R Kesimp
Kasus | diharapkan Hasil Uji ulan
Lampu luar
Kondisi yang
cahaya asalanya
terang menyala OK
menjadi
mati
6. Pengujian Sensor Infrared
Menampilkan kondisi relay unplug pada aplikasi.

Tabel 3.11 Tabel Pengujian menampilkan kondisi

relay unplug
Kasus dan Hasil Uji

Yang Kesimp
Kasus diharapkan Hasil Uji ulan
Melihat
kondisi Menampilk -
relay an kondisi 1 oK
unplug unplug

4. Kesimpulan

Dari berbagai penjelasan yang telah diuraikan
dalam laporan ini, maka dapat disimpulkan

beberapa hal sebagai berikut:
1. Terwujud  sistem
smartphone.

wireless

melalui

2. Pengguna dapat mengontrol perangkatlistrik

secara jarak jauh.
3. Membantu pengguna yang sedang
untuk mengontrol perangkat listrik.

5. Saran

Agar dapat berjalan dengan baik dan dapat
mencapai tujuan secara maksimal, maka

dibutuhkannya hal-hal pendukung.
Menyangkut hal ini maka rekomendasi
yang diusulkan diantaranya:

sakit

1. Menggunakan suatu sistem informasi yang
dapat dikembangkan lebih lanjut sehingga
dapat memberikan informasi yang lebih
lengkap kepada pengguna.

2. Perancangan ini dapat dijadikan acuan
dalam pengembangan sistem lainnya,
seperti  otomatisasi keamanan rumah
maupun alat listrik otomatis.

3. Menindaklanjuti prototype ini dengan
mengimplementasikannya pada skala rumah
sesungguhnya.
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